Streamlining of the Traffic Modeling Process for Implementation in the Twin Cities Freeway Network - Phase II
Comprehensive methodologies are proposed for improving the quality of both freeway and arterial intersections traffic volumes for the purpose of enabling and improving traffic simulations. Specifically, established and enhanced procedures for checking and correcting freeway temporal errors are integrated with an optimization-based algorithm for reconciling spatial inconsistencies in freeway traffic counts. In addition to this, an empirical methodology is further integrated to balance arterial intersection traffic counts. The proposed methodologies have been successfully automated and implemented as two computer programs, i.e., TradaX for processing freeway volume and ArtBaT for arterial intersection traffic counts. Initial evaluations of these tools suggest that they have the potential of reducing total modeling time by 25% ~ 30%, while resulting in improved calibration of simulation models, more reliable analysis, and better use of staff resources for meeting project deadlines.
Streamlining of the Traffic Modeling Process for Implementation in the Twin Cities Freeway Network - Phase II

Final Report

Prepared by:
Wuping Xin
John Hourdos
Panos Michalopoulos

University of Minnesota
Department of Civil Engineering

May 2006

Published by:
Minnesota Department of Transportation
Research Services Section
395 John Ireland Boulevard, MS 330
St. Paul, Minnesota 55155

This report represents the results of research conducted by the authors and does not necessarily represent the views or policies of the Minnesota Department of Transportation and/or the Center for Transportation Studies. This report does not contain a standard or specified technique.

The authors and the Minnesota Department of Transportation do not endorse products or manufacturers. Trade or manufacturers’ names appear herein solely because they are considered essential to this report.
# Table of Contents

1. INTRODUCTION..............................................................................................1
2. BACKGROUND................................................................................................3
3. CHECKING AND CORRECTING METHODOLOGY .........................5
   3.1 Unified Traffic Data Format..............................................................5
   3.2 Classification of Data Errors..............................................................6
   3.3 Checking Methodology.....................................................................8
   3.4 Correcting Methodology.................................................................13
4. RECONCILING METHODOLOGY.......................................................15
   4.1 Identification of Spatial Discrepancies........................................15
   4.2 Reconciling Spatial Discrepancies................................................16
5. ARTERIAL BALANCING METHODOLOGY.................................19
   5.1 Data Normalization.........................................................................19
   5.2 Data Matching.................................................................................20
   5.3 Data Balancing...............................................................................22
REFERENCE..................................................................................................23

APPENDIX A  TradaX 2.0 User Manual
APPENDIX B  ArtBaT 1.0 User Manual
List of Figures

Figure 3.1 Traffic Volumes Temporal Outliers ...........................................7
Figure 3.2 Spatial Discrepancies .................................................................7
Figure 3.3 Scanning Log Showing Partial Missing Rate for Detectors/Stations...9
Figure 3.4 Filtering Missing Data Flow Chart .............................................10
Figure 3.5 (a) Traffic Volume Outliers .........................................................12
Figure 3.5 (b) Z-Statistics for Traffic Volumes ...........................................12
Figure 3.6 Flow Chart for Correcting Missing Data ....................................14
Figure 4.1 Numerical examples illustrating the data balancing algorithm........17
Figure 5.1 (a). Example illustrating how to match arterial intersection data to balanced freeway data (before matching) .................................................21
Figure 5.1 (b). Example illustrating how to match arterial intersection data to balanced freeway data (after matching) .................................................21
Executive Summary

In recent years, micro-simulation has become an increasingly indispensable tool in many demanding ITS and planning applications. In order to build reliable and realistic simulation models, high-quality input data are required including roadway geometry, vehicle/driver characteristics, traffic volumes, composition, and others. Among these data, volumes are of major importance yet they are hard to obtain; even when collected with advanced surveillance systems they are still susceptible to problems such as miscounting, gaps in time and space and other inaccuracies. More importantly, even when the data appear to be accurate, frequently they do not balance out, i.e., they are inconsistent in terms of maintaining conservation throughout the system. Inevitably, these problems could lead to anomalies or considerable errors during the simulation, seriously tainting the reliability and accuracy of its outputs while weakening the credibility of the resulting conclusions.

In this study, systematic methodologies have been proposed to check/correct common temporal errors for freeway volumes. These methodologies also include rigorous methods for reconciling both freeway volumes and arterial turning movement counts. Specifically, the freeway data processing methodology can handle common temporal data errors including missing data, locked-on data, threshold violations, temporal outliers, as well as spatial discrepancies. Established procedures in conjunction with a fitted ARIMA model are used to check and correct common temporal freeway data errors, while an optimization-based approach is proposed to identify and reconcile spatial gaps in freeway traffic counts on a system wide scale. In addition to this, an empirical methodology is also integrated to balance arterial intersection traffic counts.

The proposed methodologies have been successfully automated and incorporated into two standard Windows programs called Freeway Traffic Data Analysis Tool (TradaX) and Arterial Data Balance Tool (ArtBaT). In a nutshell, TradaX provides a
user-friendly interface, comprehensive data-processing and graphical functionalities. These functionalities automate the data pre-processing tasks required in practical simulation projects. These tasks used to be tedious and error-prone. In addition, the arterial intersection traffic balancing methodology is automated and implemented in the ArtBaT program. ArtBaT can build user-defined intersection layouts and is capable of handling up to 17 types of intersections. More importantly, ArtBaT is designed to be capable of interfacing with TradaX and the JAMAR intersection data collector. JAMAR collector is commonly used by traffic engineering professionals to collect arterial intersection data. The flexible interface of ArtBaT greatly facilitates data preparation for Interstate Access Request (IAR) projects, which require both balanced freeway as well as adjacent arterial intersection data.

Initial evaluations of these tools suggest that they have the potential of reducing total modeling time by 25% ~ 30%, while resulting in improved calibration of simulation models, more reliable analysis, and better use of staff resources for meeting project deadlines.
1 INTRODUCTION

In response to the growing need for improving the design and performance of roadway facilities as well as for implementing innovative ITS technologies, engineers are now increasingly relying on sophisticated, high-fidelity microscopic traffic simulators rather than conventional approaches. Recognizing simulation’s effectiveness and improved realism, the Federal Highway Administration (FHWA) recently introduced a mandate requiring comprehensive simulation analysis to be conducted for all new Interstate Access Requests (IAR) prior to actual implementation. In this regard, high-quality input data are essential for building realistic and accurate simulation models; such data include the roadway geometry, vehicle/driver characteristics, traffic volumes, composition, and others. Among these data, traffic volumes are of major importance as they are the starting point for generating traffic demands and developing traffic control scenarios, and serve as essential inputs for model calibration. However, reliable traffic volume data more often than not are hard to obtain; even when collected with advanced surveillance systems they are still susceptible to problems such as miscounting, gaps in time and space and other inaccuracies caused by malfunctioning sensors. More importantly, even though the data may appear to be accurate, frequently they do not balance out, i.e., they are inconsistent in terms of maintaining traffic conservation throughout the system, resulting in inaccurate traffic demands, unrealistic control decisions, and erroneous adjustments of model parameters during calibration. Inevitably, these problems could lead to anomalies or considerable errors during the simulation, seriously tainting the reliability and accuracy of its outputs while weakening the credibility of resulting conclusions.

Specifically, traffic volume data required in simulation include freeway volume data and arterial intersection turning movements’ counts. For freeway volume data, practical procedures and guidelines have been proposed in the literature for reviewing and correcting common temporal errors [1-8]; however, most of them are not intended for simulation purposes, while a unified systematic methodology is still lacking for checking and correcting temporal data errors in conjunction with reconciling spatial gaps in traffic counts. Likewise, frequently arterial intersection turning movement counts are susceptible to errors of spatial gaps, yet there seems no well established methodology existing in the literatures as to reconciling such gaps for simulation purpose.

In this study, systematic methodologies have been proposed to check/correct common temporal errors for freeway volumes. These methodologies also include rigorous methods for reconciling both freeway volumes and arterial turning movement counts. The proposed methodologies have been successfully automated and incorporated into two computer programs called Freeway Traffic Data Analysis Tool (TradaX) and
Arterial Data Balance Tool (ArtBaT). Initial evaluations of these tools suggest that they have the potential of reducing total modeling time by 25% ~ 30%, while resulting in improved calibration of simulation models, more reliable analysis, and better use of staff resources for meeting project deadlines.
2 BACKGROUND

The methodologies proposed in this study concentrate on improving the quality of traffic volume data with the objective of enabling and improving traffic simulation. This includes the integration of established procedures dealing with common temporal errors with a new optimization-based algorithm reconciling spatial discrepancies. To be sure, checking and correcting temporal volume errors, e.g., missing data, threshold violations, or suspicious outliers, are not new and have been widely studied in previous research [e.g., 9, 10, 11, 12, 13]. However, spatial discrepancies of traffic volumes do not seem to have been adequately addressed; there is no guidance in the literature on precisely what constitute a large discrepancy, nor does an effective methodology seem to exist for checking and reconciling system-wide discrepancies [14].

Existing procedures for checking temporal volume errors include tests for missing data, threshold violation, locked-on sensors, data inconsistency, and temporal outliers. Missing data refers to a situation where a detector fails to report any data within some time duration. This is sometimes called data “holes” in the data set. Threshold violation tests refer to the comparison of traffic measurements with prescribed upper and lower bounds. For example, the lower/upper bounds for traffic volume used in Maryland are based on historical data, while in Minnesota, a lower bound of 20 veh/5-min per lane and an upper bound of 250 veh/5-min per lane are used [2]. Lock-on sensors refer to situations where traffic measurements remain identical for several consecutive data collection intervals. When this occurs, the values are in most cases zero, but runs of values other than zero could also occur. Schmoye et al. [4] provided an empirical method for determining the feasible run length (i.e., number of collection intervals) of identical values. If the number of time intervals with identical values became greater than a pre-determined run length, the data were considered to be invalid. Another type of data error occurs when traffic volume and occupancy measurements contradict each other, e.g., zero volume with non-zero occupancy, or zero occupancy with non-zero volume. Payne and Thompson [3] identified this as inconsistent data and proposed a test for its detection.

Temporal outliers refer to suspicious observations in the time series of traffic measurements. Usually they are in the form of abrupt increases or decreases inconsistent with the general pattern. Neural Network models, Genetic Algorithms and Autoregressive Integrated Moving Average models (ARIMA) have been applied to the outlier detection problem, mostly in other engineering domains. In the context of traffic, a Fourier-based framework has been recently developed to detect outliers in real-time traffic measurements [5] for the purpose of on-line control. In addition, a fuzzy-clustering approach was also applied in identifying and correcting outliers in archived traffic data [6].
Once faulty data are identified, they are excluded from the data set, or corrected either empirically or using statistical methods. For example, Payne and Thompson [3] used historical traffic information and the data from adjacent detectors to replace data holes, while Turner et al [11] used regression and time series models, Chen et al. [12] used lane-to-lane and location-to-location correlations to impute missing data. In addition, if the faulty measurement was determined to be a temporal outlier, its model-predicted [5] or smoothed value [6] was used as a replacement.

Apart from the aforementioned errors, frequently traffic volumes do not balance out, i.e., they are inconsistent in terms of maintaining traffic conservation throughout the system. In such cases, large discrepancies exist between traffic counts upstream and downstream of specific locations. These spatial discrepancies may result from any of the aforementioned errors, storage or discharge of queuing vehicles on the freeway, traffic sinks or sources not accounted for, using data collected on different days or time intervals, or simply averaging over different days at each measurement station without checking conservation. Discrepancies may also arise from the inconsistent projection of the base year demands into future years. As mentioned earlier, spatial discrepancies of traffic counts have not been well addressed in previous studies.
3 CHECKING AND CORRECTING METHODOLOGY

This section presents the checking and correcting methodology implemented in TradaX.

3.1 UNIFIED TRAFFIC DATA FORMAT

The Minnesota Department of Transportation (Mn/DOT) has one of the largest traffic data collection systems in the United States. This system consists of more than 4000 loop detectors collecting traffic volume (number of vehicles), and occupancy (percentage of time a detector is “occupied” by a passing vehicle) data in real time every 30 seconds.

As the benefits of storing this large amount of data in a traditional database are far offset by the accompanied complications, Mn/DOT finally turned to a Unified Traffic Data File Format (UTDFF). In this format, raw traffic data is stored as 8-bit (volume data) or 16-bit binary numbers (occupancy data). This simple and compact format greatly facilitates everyday data storage/retrieval, as well as development of data analysis tools such as TradaX.

In UTDFF data format, each detector has two data files associated with it, i.e. volume file (*.v30) and occupancy file (*.c30). The volume file (*.v30) is a flat binary file with 2880 bytes in length. Each byte is an 8-bit signed integer corresponding to a 30-second vehicle count. Within each volume file, the integer value of the first byte represents the first 30-second vehicle counts of the day (i.e., from midnight to 12:00:30 am), while the last value corresponds to the final 30-second vehicle counts of that day (i.e., from 11:59:30 to midnight). A negative value (0xFF) indicates missing data (this 0xFF is generated by hardware controller if it receives no data from detector).

The occupancy file (*.c30) is akin to volume files, except that each value is a 16-bit signed integer. This means each file is 5760 bytes in length. As with the volume file, a negative value (0xFFFF) indicates missing data.

In the end, all the detectors’ volume and occupancy files are zipped into one single file on a daily basis. This single file is conventionally named with an 8-digit date followed by an extension of “.traffic”. For example, “20031105.traffic” would contain all the detectors’ volume and occupancy data of Nov 5th, 2003.
3.2 CLASSIFICATION OF DATA ERRORS

*TradaX* identifies and corrects data errors from two categories: common temporal errors and spatial discrepancies.

(1). Common temporal errors refer to missing data, locked on sensors, contradictory data, threshold violations, and temporal outliers. Such errors are called temporal because they are associated with the time series of the measurements at each individual detector.

(2). Missing Data refers to situation where a detector fails to report any data within some time duration. This is sometimes called data “holes” in the data set.

(3). Lock-on Sensors means traffic measurements (both volume and occupancy) remain identical values for several consecutive data collection intervals. When this occurs, the values were most often zero, but cases of values other than zero also are also frequent. When the identical value is zero, *TradaX* considers such situation the same as data missing.

(4). Contradictory Data refers to the situation where traffic volume and occupancy measurements contradict each other, e.g., zero volume with non-zero occupancy, or zero occupancy with non-zero volume. *TradaX* considers contradictory data the same as missing data (volume or occupancy missing).

(5). Threshold Violation means the collected traffic measurements exceed reasonable upper and lower bounds. For example, 300 veh/5 minutes/lane is an out-of-bound value as it entails an average flow rate of 1 veh/sec for the entire 5-minute period. Different thresholds can be prescribed in practice to test the data. In Maryland, the lower/upper bounds for traffic volume are based on historical data, while in Minnesota, a lower bound of 20 veh/5-min per lane and an upper bound of 250 veh/5-min per lane are used.

(6). Temporal outliers refer to suspicious observations in the time series of traffic measurements. Usually they are in the form of abrupt increases or decreases inconsistent with the general pattern (See Figure 3.1).

(7). Spatial Discrepancies refers to the situation where traffic volumes do not balance out, i.e., they are inconsistent in terms of maintaining traffic conservation throughout the system (See Figure 3.2). In such cases, large gaps exist between traffic counts upstream and downstream of specific locations. These spatial discrepancies may result from any of the aforementioned errors, storage or discharge of queuing vehicles on the freeway, traffic sinks or sources not accounted for, using data collected on different days or time intervals, or simply averaging over different days at each measurement station without checking conservation. Discrepancies may also arise from the inconsistent projection of the base year demands into future years.
Figure 3.1 Traffic Volume Temporal Outliers (Three temporal outliers are indicated by arrows)

Figure 3.2 Spatial Discrepancies
For spatially correlated traffic detector stations, total input volume should approximate total output volume during a given time period. As is shown in Figure 3.2, M1, M2, M3 are three mainline detector stations, E1 and E2 are two entrance detector stations. If traffic volumes are balanced, vehicle counts at (M1+E1) should approximately equal to those at M2.
3.3 CHECKING METHODOLOGY

Partial Missing Rate
As introduced earlier, raw volume and occupancy are collected on a 30-second basis. These raw data are stored as 8-bit (volume data) or 16-bit binary numbers (occupancy data). If during a 30-second interval, the hardware controller receives no data from the detector, binary number 0xFF (8-bit binary representation of -1) or 0xFFFF (16-bit binary representation of -1) will be used to indicate data “holes” for volume or occupancy respectively.

It is required in many practical projects that raw 30-sec data (volume or occupancy, or both) be aggregated into longer time interval such as 5 minutes or 15 minutes. This leads to the concept of “Partial Missing Rate” (PMR). Specifically, PMR is defined as the time percentage of the entire aggregation interval during which the measurement is missing. The next example best illustrates this concept.

Assuming that raw 30-sec volume data are being aggregated into a 5-minute volume, i.e., 10 successive 30-sec volumes are added up to yield a 5-minute volume. If four out of the ten 30-sec volume data are missing (i.e., they are flagged as “-1” by the controller), the Partial Missing Rate for the aggregated 5-minute volume will be 40% (4 divided by 10). Note that TradaX computes the Partial Missing Rate for any aggregated time interval greater than 30-sec.

Checking Missing Data
TradaX filters missing data by first checking the Partial Missing Rate (PMR). If the PMR of an aggregated volume (or occupancy) is non-zero, TradaX will flag such data as missing and report related information in the data scanning log (Figure 3.3). As Figure 3.3 shows, Detector 1351 (which belongs to Station 426) at 19:00 have 3% volume missing, meaning from 18:55 to 19:00, three of the ten 30-sec raw volume data are missing.
Apart from the hardware reported data missing, *TradaX* also applies the following heuristic rules to supplement the determination of missing data. Note if any of the following rules are found to hold, the related measurement will be flagged as 100% missing and reported in the scanning log accordingly:

1. Zero Volume with non-zero occupancy (100 % volume missing);
2. Zero Occupancy with non-zero volume (100% occupancy missing);
3. Non-HOV detectors report zero volume and zero occupancy for 2 consecutive aggregated time intervals (100 % volume missing and 100% occupancy missing);

Note that HOV detectors are not included in Rule 3, as it is highly probable for HOV detectors to have zero measurements during multiple data collecting periods. Further, it should be stressed that Rule 3 is very likely to generate a false alarm during non-peak periods, e.g., from midnight to 4:00 a.m. in the morning. In this case, the user is strongly suggested to examine the *Data Scanning Log* and visually check/verify the reported missing data (during non-peak hours) using the *Data Graphics* function. Figure 3.4 gives the flow chart for filtering missing data.

**Filtering Locked-on Sensors and Threshold Violations**

*TradaX* considers the data as locked on if both volume and occupancy have non-zero values and remain identical (unchanged) for two consecutive data aggregation intervals. Furthermore, if the data exceed user-defined threshold values *TradaX* will flag the data as violating thresholds,
Figure 3.4 Filtering Missing Data Flow Chart
Filtering Temporal Outliers

In order to filter temporal outliers, the ARIMA \((p,d,q)\) model was selected in this study and fitted using field data to determine the best parameters. Specifically, the ARIMA \((p, d, q)\) model can be represented as:

\[
x_t = \xi + \phi_1 x_{t-1} + \phi_2 x_{t-2} + ... + \phi_p x_{t-p} - \theta_1 \varepsilon_{t-1} - \theta_2 \varepsilon_{t-2} - ... - \theta_q \varepsilon_{t-q} + \varepsilon_t
\]

(1)

where

- \(\xi\) is a constant;
- \(x_t\) represents the observation at time \(t\);
- \(\phi_n\) is the autoregressive parameter, \(n=1,2,...,p\);
- \(\theta_n\) is the moving average parameter, \(n=1,2,...,q\);
- \(\varepsilon_t\) is white noise random error at time \(t\), \(\varepsilon_t \sim WN(0,\sigma^2)\);
- \(p\) is the number of autoregressive terms;
- \(q\) is the number of moving average terms;
- \(d\) is the order of differencing needed to make the time series stationary.

It should be noted that the ARIMA model only applies to stationary time series (i.e., for time series \(\{x_t\}\), the mean value \(E(x_t)\) is constant and the covariance \(E(x_t, x_{t-h})\) is only dependent on the time lag \(h\)). In this study, the ARIMA model represented by equation (1) was fitted to historical traffic counts and occupancy time series to determine the appropriate \(p, d,\) and \(q\) values. The historical data were measured at 10 randomly selected detectors from the Twin Cities freeway network. Note that traffic counts and occupancy measurements are non-stationary as they clearly have time-dependent tendencies. In order to produce stationary time series from these measurements, the square root was calculated followed by differencing until stationary time series were obtained. After some experimentation, the ARIMA \((1, 1, 1)\) model was found to be most appropriate for modeling the square root of the traffic count and occupancy time series for all the detectors.

The fitted ARIMA model produces a prediction of the likely actual measurements at each time interval based on the preceding measurements. At any time interval, the difference between the predicted value and actual observation produces a residual. A measurement is labeled as outlier if the standardized residual exceeds a specified confidence level. For instance, any standardized residual value greater than 1.96 would indicate a highly probable temporal outlier with 95% confidence level. Figure 3.5 illustrates an example of traffic sensor volume measurements (loop detector No.982 on I-94, August 3\(^{rd}\), 2000). In this figure, three suspicious outliers are indicated by the arrows. Figure 3.4 also includes the z-statistics of the residuals after the fitted ARIMA model has been applied. It is clearly depicted in the figure that the
three suspicious outliers correspond to high z-statistics exceeding the critical residual value.

Figure 3.5 (a) Traffic Volume Outliers

Figure 3.5 (b) Z-Statistics for Traffic Volumes
3.4 CORRECTING METHODOLOGY

Correcting Missing Data
The flow chart for correcting missing data is depicted in Figure 3.6. As is shown in the flow chart, detectors that have been flagged with a specific Partial Volume Missing Rate smaller than 100% will be fixed by “rescaling.” This means that true measurement values will be reconstructed by “rescaling” raw data according to the partial missing rate. For example, if a measurement of 50 veh/5-min is flagged as “40% volume missing,” the reconstructed volume will be \( \frac{50}{1 - 0.40} = 83 \) veh/5-min.

Further, detectors that are flagged as “100 % VOL Missing” will be fixed using adjusted “sibling” (adjacent detectors in the same station) detector’s volume, or conservation computation if “siblings” are not available, or applying historical data if neither of the above works. Similarly, “100 % OCC missing” will be fixed using “sibling” measurement or historical data. Note that in case historical data is also missing, predefined default value will be used to fill the data “holes.”

Correcting Locked on Sensors and Threshold Violations
Threshold violations are corrected using prescribed upper or lower bounds for the related measurements. Locked-on sensors are corrected in the balancing stage to be detailed next.

Correcting Temporal Outliers
Detected temporal outliers are corrected using the predicted value generated by the ARIMA model as discussed in preceding sections.
Figure 3.6. Flow Chart for Correcting Missing Data
4 RECONCILING METHODOLOGY

4.1 IDENTIFICATION OF SPATIAL DISCREPANCIES

Once the temporal errors have been processed throughout the dataset, jumps or drops of traffic counts at all nearby adjacent mainline counting stations are checked in sequential order (i.e., from upstream to downstream). Specifically, for every freeway section between two successive mainline counting stations, the difference between total input (i.e., total traffic counts at the upstream counting station and entrance ramps) and output volumes (i.e., total counts at the downstream counting station and exit ramps) is computed for every data collection interval. If the discrepancy (denoted as $\Delta C$) exceeds a reasonable threshold, then this discrepancy is considered large enough and needs to be reconciled.

In order to determine the allowable discrepancy threshold $\Delta C$, the concept of traffic conservation is considered:

$$\int_{t}^{t+\Delta t} q(x_u,t)dt + \sum_{e \in E} \int_{t}^{t+\Delta t} q(x_e,t)dt - \left[ \int_{t}^{t+\Delta t} q(x_d,t)dt + \sum_{e \in X} \int_{t}^{t+\Delta t} q(x_{ex},t)dt \right]$$

where $\Delta t$ is the data collection interval (e.g., 5 min or 15 min); $E$ is the index set for counting stations at entrance ramps; $X$ is the index set for counting stations at exit ramps; $q(x_u,t), q(x_d,t), q(x_e,t), q(x_{ex},t)$ are the flow rate at upstream, downstream, entrance ramp and exit ramp counting stations, respectively; $k(x,t)$ is traffic density of the freeway section delimited by upstream and downstream counting stations. The left-hand side of Equation (2) is equivalent to the difference between total input and output during interval $\Delta t$, which equals $\Delta C$; the right-hand side of Equation (2) can be approximated from

$$[k(x,t + \Delta t) - k(x,t)](x_d - x_u) = [k(x,t + \Delta t) - k(x,t)] \Delta x$$

where $\Delta x$ is the distance between upstream and downstream counting stations. Using the relationship between occupancy measurement and traffic density:

$$K = \frac{O}{L + C}$$

where $O$ is occupancy measurement, $K$ is density, $L$ is average vehicle length, $C$ is the detector length, Equation (4) can be simplified to:

$$\Delta C = [K(t + \Delta t) - K(t)] \times \Delta x$$
where $K(t)$ and $K(t + \Delta t)$ are traffic densities approximated from Equation (3).

Equation (4) gives the allowable upper bound for the discrepancies of traffic counts, i.e., if the computed discrepancy exceeds the bounds defined by $|[K(t + \Delta t) - K(t)] \times \Delta t|$, then such a discrepancy is considered to violate traffic conservation therefore needs to be reconciled. However, it is important to clarify that if the counting interval is sufficiently long, or the analyst is only interested in homogeneous state of traffic, where traffic density is assumed to be uniform (i.e., time and space invariant), then $\Delta C = 0$, meaning that the total input should always equal to the total output of the freeway section. NOTE: In the current version of TradaX, $\Delta C$ is hard-coded as 0, meaning TradaX always balance traffic volume to zero.

### 4.2 RECONCILING SPATIAL DISCREPANCIES

The identified large discrepancies in traffic counts are reconciled in this step. First denote the number of the counting stations under study (including stations on mainline, entrance and exit ramps) as $N_{sta}$. At counting interval $t$, for the counting station $i$ let $y_i(t)$ denote raw field measurement of traffic counts, $x_i(t)$ denote the true measurement of traffic counts, and $\varepsilon_i(t)$ the measurement error. Then $y_i(t)$ can be expressed as

$$y_i(t) = x_i(t) + \varepsilon_i(t), \ i = 1, 2 \ldots N_{sta}$$  \hspace{1cm} (5)

The measurement errors $\varepsilon_i(t)$ in Equation (5) may be in relation to errors discussed in preceding sections, inconsistent adjustments between different days, or small random miscounting errors due to unknown reasons.

Note that counting stations are deployed in certain spatial arrangement; this triggers conservation constraints, i.e., for spatially related counting stations on a given freeway section, the difference between input and output equals the change of vehicle storage during the specified counting interval. In order to reconcile large discrepancies in traffic counts while at the same time minimize the measurement errors, the following optimization formulation is used:

$$\text{minimize } \sum_i \varepsilon_i(t) = \sum_i [y_i(t) - x_i(t)]^2, \forall t$$ \hspace{1cm} (6)

s.t.

Conservation Constraints as In Equation (2)

$x_i(t) \geq 0, \ i = 1, 2, \ldots , N_{sta}$
The objective of the above formulation is to determine the most plausible actual values $x_i$ when the field measurements $y_i$ are given without materially affecting the actual trends in the traffic patterns. The objective is to minimize the total measurement errors, while the conservation constraints ensure that the final optimizer $x_i$, $i = 1, 2, ..., N_{sta}$ complies with the conservation concept. This means that any discrepancies in traffic counts are implicitly resolved during this optimization process. The relaxed constraint $x_i < \infty$ holds for station $i$ flagged as problematic in the previous stage of checking and correcting temporal errors, or for stations with adjusted/projected counts. This is necessary otherwise the errors associated with a specific counting station will be distributed over other “healthy” stations. As stations diagnosed as “healthy” could still have inherent small random errors, the constraint $\left| \frac{x_i(t) - y_i(t)}{y_i(t)} \right| < p\%$ is added to reflect this, where $p\%$ represents the desired measurement precision of the related detectors, stated otherwise it is also an indicator reflecting the analyst’s desired confidence level based on professional judgments.

**Numerical Example**

Assuming during a certain time interval, field measurements for counting Station1~7 are as follows (Figure 4.1):

\[
\begin{align*}
y_1 &= 20 \text{ veh} \\
y_2 &= 20 \text{ veh} \\
y_3 &= 170 \text{ veh}
\end{align*}
\]
\[ \Delta \text{ storage}_1 = 10 \text{ veh} \]
\[ y_4 = 30 \text{ veh} \]
\[ y_5 = 95 \text{ veh} \]
\[ \Delta \text{ storage}_2 = 15 \text{ veh} \]
\[ y_6 = 40 \text{ veh} \]
\[ y_7 = 40 \text{ veh} \]
\[ \Delta \text{ storage}_3 = 10 \text{ veh} \]

Furthermore, assuming Station 3 and Station 7 are flagged as “threshold violations” and “temporal outlier” respectively. Thus we have the following optimization problem:

\[
\text{min} \ (x_1 - 20)^2 + (x_2 - 20)^2 + (x_3 - 170)^2 + (x_4 - 30)^2 + (x_5 - 95)^2 + (x_6 - 40)^2 + (x_7 - 40)^2
\]

**Subject to**

Conservation Constraints:

\[
\begin{align*}
\quad x_1 + x_2 - x_3 &= 10 \\
\quad x_3 + x_4 - x_5 &= -15 \\
\quad x_5 - x_6 - x_7 &= -10
\end{align*}
\]

Non-negative Constraints: \( x_i \geq 0 \), for \( i = 1, 2, \ldots, 7 \)

Precision Constraints: \( \left| \frac{x_i(t) - y_i(t)}{y_i(t)} \right| < 3\% \), for \( i \neq 3, i \neq 7 \)

Relaxed Constraints: \( x_3 \leq \infty \); \( x_7 \leq \infty \)

Solving the above optimization problem yields the optimized solutions:

\( (x_1, x_2, x_3, x_4, x_5, x_6, x_7) = (22, 22, 54, 28, 97, 44, 63) \)
5 ARTERIAL BALANCING METHODOLOGY

This section describes the underlying methodology employed in the ArtBaT program. Specifically, this methodology involves three stages: data normalization, data matching, and data balancing.

5.1 DATA NORMALIZATION

Intersection volume data sets are collections of 15-minute volume for individual turning movement (e.g., 50 left-turn vehicles, 100 right-turn vehicles, 276 through vehicles, etc) collected over a 3 hour time period. As the number of intersections requiring turning movement counts usually exceeds the available manpower, turning movements are seldom collected on the same day or even the same month. Therefore, turning movements should be first normalized (adjusted) to match the month and day of the balanced freeway data, should monthly/daily adjustment factors be available. To normalize arterial turning movement data, the following formula is used:

\[ Vol_2 = \frac{Vol_1 \times M_1 \times D_1}{M_2 \times D_2} \]  

(7)

where

- \( Vol_1 \): Raw arterial volume.
- \( Vol_2 \): Normalized arterial volume.
- \( M_1 \): Monthly adjustment factor for the month when the arterial data was collected.
- \( M_2 \): Monthly adjustment factor for the month of the balanced freeway data.
- \( D_1 \): Daily adjustment factor for the day when the arterial data was collected.
- \( D_2 \): Daily adjustment factor for the day of the balanced freeway data.
**Data Normalization Example**

Assume that on a Wednesday in May, 100 thru vehicles were counted at a certain intersection approach; while the balanced freeway data are given for a Tuesday in September. In addition, the adjustment factors are given as:

- Monthly adjustment factors: May 0.95, September 0.85;
- Daily adjustment factors: Wednesday 1.10, Tuesday 1.15.

In order to match the date of the freeway data, the normalized arterial data are computed as:

\[
Vol_2 = \frac{100 \times 0.95 \times 1.10}{0.85 \times 1.15} = 107
\]

---

**5.2 DATA MATCHING**

The balanced arterial data must match the balanced freeway ramp volume. This is achieved by using the raw turning movement volume to determine the percentage of left-turn, right-turn, and thru movements on *ramp intersection legs*. These percentages are applied to the balanced freeway ramp data to get the new volumes which are then locked when balancing the remaining arterial volumes.

**Data Matching Example**

Assume that the collected arterial data includes 35 left-turn and 87 right-turn vehicles for a ramp leg (Figure 5.1(a)). This gives the percentage of left turn vehicles as \( \frac{35}{35 + 87} = 28.6\% \) and right turn vehicles as \( \frac{87}{35 + 87} = 71.4\% \). However, the freeway ramp volume is reported to be 135 vehicles (as a result of freeway balancing). Therefore, the matched new arterial volumes for this leg are 135 \( \times 28.6\% = 39 \) left-turn vehicles and 135 \( \times 71.4\% = 96 \) right-turn vehicles. These movements are then locked while balancing the remaining arterial data (Figure 5.1 (b)).
Figure 5.1 (a). Example illustrating how to match arterial intersection data to balanced freeway data (before matching).

Figure 5.1 (b). Example illustrating how to match arterial intersection data to balanced freeway data (after matching).
5.3 DATA BALANCING

In a nutshell, balancing arterial intersection turning movement data means adjusting the relevant turning movement volumes so that the total traffic entering a link equals the total traffic exiting the link. This is conducted by proportioning the extra link volume (i.e., the volume difference between the total inflow and total outflow of a link) among any movements that can be changed. Specifically, the formula used in this process is:

\[
\bar{V}_{ij} = V_{ij} \pm \Delta V \left( \frac{V_{ij}}{\sum V_{ij}} \right)
\]

where:

\( \bar{V}_{ij} \) = the balanced volume of movement \( j \) in direction \( i \);

\( V_{ij} \) = the raw volume data for movement \( j \) in direction \( i \);

\( \Delta V \) = the volume differential between turning count data sets for a specific link.
REFERENCES


Appendix A
Freeway Traffic Data Filtering and Balancing Tool

*TradaX Version 2.0*

User Manual
SOFTWARE OVERVIEW

INTRODUCTION

TradaX (Traffic Data Analysis) is a Windows© software package designed and developed at the University of Minnesota for filtering, correcting and balancing freeway traffic data. It can automatically identify freeway geometry and retrieve traffic data in UTDFF format, filter and correct data faults, and reconcile spatial discrepancies of traffic volumes. It also provides rich graphical functionalities and flexible data output options to facilitate data examination and outputs.

TradaX integrates empirical procedures, in conjunction with a validated ARIMA (Auto-Regressive Integrated Moving Average) model to filter and correct common temporal data errors; while a non-linear optimization algorithm has been developed and implemented in TradaX to balance the identified gaps of traffic counts on a system-scale.

INSTALLATION

System Recommendations

<table>
<thead>
<tr>
<th>CPU</th>
<th>&gt; 1GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>256MB (512 MB Preferable)</td>
</tr>
<tr>
<td>Operating Systems</td>
<td>Windows ME/NT/2000/XP</td>
</tr>
<tr>
<td>Resolution</td>
<td>1280 × 960 Preferable</td>
</tr>
</tbody>
</table>

Installation Directions

The installation package includes user manuals, samples and executable program. Two types of installation are available:

**Beta Version**
1. Select a working directory and unzip TradaX.zip file (Windows Registry will not be modified);
2. Double click TradaX.exe to start the program;
3. To uninstall, delete all the files in the working directory;

**Release Version**
1. Before installing, it is suggested to close any running Windows programs;
2. To install new TradaX, click setup.exe and follow the screen instructions;
3. To uninstall, from START menu, under TradaX directory click UNINSTALL, the uninstall program will automatically remove the software from the computer.
USER INTERFACE

TRADAX INTRODUCTION PAGE

When starting TradaX.exe, TradaX introductory page will first show up. This page provides general information of the program, including built date and system resources information.

TREE VIEW OF ACTION LISTS

TradaX organizes its functionalities via a tree view list (located in the left part of the interface). The tree view has three father nodes: Data Processing, Data Graphics, and Help, corresponding to three major functionalities provided by TradaX.
Data Processing includes:
- Data Extraction
- Data Fix
- Data Balance;

Data Graphics can generate graphics for Raw Data, Fixed Data and Balanced Data while Help provides on-line help for the user.

TIPS The user can use either the Tree View List or the “Previous”/“Next” button to navigate through user interfaces.

EXTRACT BINARY TRAFFIC DATA

Prior to fixing and balancing, traffic data must be loaded (extracted) into TradaX memory. Figure A.3 shows the general information page of Extract Data functionality. The user can click the link on the page, the action node in the tree view, or Next button to proceed.

Load Station File

Before starting to extract data, a station file needs to be loaded. Station files are ASCII files with .sta extension. It provides a convenient way describing the spatial layout of detector stations that are deployed on the freeway.
A station file can be easily created/edited with *Station File Editor*, or any text editor such as notepad.exe as long as it complies with the prescribed data format.

An example of a station file:

```
......
426, M, 2, 1350, 1351
1352 X, 1, 1352
427, M, 2, 1353, 1354
......
1919, H, 1, 1919
```

Each line in station file describes name and type of the detector station (mainline, entrance ramp, exit ramp, HOV ramp), the number of detectors in the station, and IDs of each composing detector. For instance, “426, M, 2, 1350, 1351” describes detector Station 426, which is a mainline station with 2 detectors. The IDs of the two detectors are 1350 and 1351 respectively.

Click *Browse* to browse and select an existing station file. See Figure A.4
The contents of the selected station file is shown in TradaX. To proceed, the user needs to click *Load* for TradaX to establish data; then click *Next* button to next page.
Load and Extract Binary Data

Browse and Load Binary Traffic File
Once the station file has been loaded, TradaX needs to know about the location of the binary traffic data file. Use Location button to navigate and select the required binary file.

Extraction Options
Time Interval
After select appropriate binary file, the data aggregation interval should be designated (the default value is 15 minutes, i.e., Tradax will aggregates 30-sec raw data into 15-min interval data).

Station Occupancy
TradaX extracts data in terms of individual detector as well as stations. Station occupancy is derived either from averaging detector occupancies, or taking highest detector occupancy.

Extract Button
Click Extract button to start extract data.

Save Options
The extracted (raw) data can be saved as .csv file either in terms of detectors or stations. The data can be in row format or column format.
An example of saved data in Row Format

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1955</td>
<td>68</td>
<td>85</td>
<td>56</td>
<td>59</td>
<td>51</td>
<td>51</td>
<td>53</td>
<td>58</td>
<td>42</td>
<td>47</td>
</tr>
<tr>
<td>3</td>
<td>1956</td>
<td>50</td>
<td>34</td>
<td>30</td>
<td>31</td>
<td>26</td>
<td>29</td>
<td>12</td>
<td>20</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1957</td>
<td>1</td>
<td>2</td>
<td>4</td>
<td>1</td>
<td>4</td>
<td>0</td>
<td>1</td>
<td>8</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1958</td>
<td>79</td>
<td>56</td>
<td>58</td>
<td>57</td>
<td>54</td>
<td>56</td>
<td>50</td>
<td>44</td>
<td>41</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1959</td>
<td>97</td>
<td>31</td>
<td>55</td>
<td>24</td>
<td>28</td>
<td>22</td>
<td>18</td>
<td>18</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>1960</td>
<td>8</td>
<td>10</td>
<td>7</td>
<td>9</td>
<td>5</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>1961</td>
<td>88</td>
<td>97</td>
<td>68</td>
<td>67</td>
<td>63</td>
<td>59</td>
<td>56</td>
<td>48</td>
<td>42</td>
<td>47</td>
</tr>
<tr>
<td>9</td>
<td>1962</td>
<td>87</td>
<td>36</td>
<td>51</td>
<td>24</td>
<td>21</td>
<td>24</td>
<td>21</td>
<td>30</td>
<td>28</td>
<td>12</td>
</tr>
<tr>
<td>10</td>
<td>1963</td>
<td>23</td>
<td>27</td>
<td>16</td>
<td>19</td>
<td>13</td>
<td>11</td>
<td>21</td>
<td>17</td>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>11</td>
<td>1964</td>
<td>69</td>
<td>66</td>
<td>32</td>
<td>54</td>
<td>47</td>
<td>48</td>
<td>34</td>
<td>49</td>
<td>40</td>
<td>27</td>
</tr>
<tr>
<td>12</td>
<td>1965</td>
<td>92</td>
<td>46</td>
<td>25</td>
<td>21</td>
<td>20</td>
<td>19</td>
<td>30</td>
<td>28</td>
<td>16</td>
<td>17</td>
</tr>
<tr>
<td>13</td>
<td>1966</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>14</td>
<td>1967</td>
<td>29</td>
<td>36</td>
<td>26</td>
<td>13</td>
<td>9</td>
<td>19</td>
<td>30</td>
<td>24</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>15</td>
<td>1968</td>
<td>9</td>
<td>5</td>
<td>3</td>
<td>1</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>3</td>
<td>0</td>
</tr>
<tr>
<td>16</td>
<td>1969</td>
<td>27</td>
<td>21</td>
<td>27</td>
<td>17</td>
<td>11</td>
<td>17</td>
<td>6</td>
<td>15</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>17</td>
<td>1970</td>
<td>11</td>
<td>11</td>
<td>7</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>8</td>
<td>8</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>

An example of saved data in Column Format

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>20050603</td>
<td>1350</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>20050603</td>
<td>1950</td>
<td>0.15</td>
<td>58</td>
<td>2.745</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>20050603</td>
<td>1350</td>
<td>0.30</td>
<td>85</td>
<td>3.964</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>20050603</td>
<td>1350</td>
<td>0.45</td>
<td>59</td>
<td>2.459</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>20050603</td>
<td>1350</td>
<td>0.60</td>
<td>59</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>20050603</td>
<td>1350</td>
<td>1.00</td>
<td>59</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>20050603</td>
<td>1350</td>
<td>1.25</td>
<td>59</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>20050603</td>
<td>1350</td>
<td>1.50</td>
<td>59</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>20050603</td>
<td>1350</td>
<td>1.75</td>
<td>59</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>20050603</td>
<td>1350</td>
<td>2.00</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>20050603</td>
<td>1350</td>
<td>2.25</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>20050603</td>
<td>1350</td>
<td>2.50</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>20050603</td>
<td>1350</td>
<td>2.75</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>20050603</td>
<td>1350</td>
<td>3.00</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>20050603</td>
<td>1350</td>
<td>3.25</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>20050603</td>
<td>1350</td>
<td>3.50</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>20050603</td>
<td>1350</td>
<td>3.75</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>20050603</td>
<td>1350</td>
<td>4.00</td>
<td>58</td>
<td>2.251</td>
<td></td>
</tr>
</tbody>
</table>
**FIX DATA**

After data have been successfully extracted, click “Next” button to the **Fix Data** general information page. This page provides general information about the “Scan for Data Errors” and “Fix Errors” functionality. Click “Next”, or select **Scan for Data Errors**, to proceed.

![Image of Fix Data General Information Page](image)

**Figure A.6 Fix Data General Information Page**

### Scan for Data Errors

*TradaX* scans the loaded data for errors. The user needs to specify volume and occupancy thresholds and the scanning log option in this page. Then click **Scan Data** button to start scanning.

![Image of Scan for Data Errors Page](image)

**Figure A.7 Scan for Data Errors Page**
Threshold Setup

The default volume and occupancy thresholds are 900 veh/15min, and 99/15min, respectively. The user can setup different threshold values through the edit box.

Outlier Detection Model

In current version of TradaX, a fitted ARIMA model is implemented to detect temporal outliers.

Scan Log Options

When data scanning is completed, a log that lists detected errors will pop up (See Figure A.8). The user can customize the log output by specifying which type of error he wishes to scan for via Scan Log Options.

The scan log can be saved as .csv file (A csv file can be opened with Microsoft Excel or any text editor such as notepad.exe) for later reference.

![Figure A.8 Scanning Log Listing Detected Errors](image)
Fix Data Page

Lane Adjustment Factor
Input Lane Adjustment Factor for different lanes (default value is 1.00), where L0 is the rightmost lane, L1 is the second rightmost lane, etc. Lane Adjustment Factor will be used when fixing missing data with adjacent detectors.

For example, if L0 volume is missing, L1 volume available, and L0 = 1.10 and L1 = 1.25; L1 has a volume of 100 veh/5min, then L0 is reconstructed by \((100 \times \frac{1.25}{1.10})\) = 114 veh/5 min.

Reference Dates for Missing Data
The two reference dates are for correcting missing data, i.e., when the missing data can not be corrected by adjacent detector value, or using conservation computation, historical data from these two dates, whichever is available, multiplied by the Daily Adjustment Factor (default value is 1.00) will be used as substitute for the missing one.

Default Value
When the missing data can not be fixed by adjacent detector, conservation computation, or historical data, the default volume value will be used to fill the data holes.
Advanced Options
By default, *TradaX* will fix 24-hour raw data for all the detectors listed in the station file. However, the user may not desire a 24-hour fixing and may wish to fix the data for a 2-hour period with only a few detectors. This can be accomplished via **Advanced Options**. To setup desired time period for fixing and specify detectors to be fixed, click Advanced button (See Figure A.10)

![Advanced Options for Fixing Data](image)

**Figure A.10 Advanced Options for Fixing Data**

Start Fixing
Click *Fix* button to start fixing the detected data errors. A Fixing Recommendations Dialogue will pop up (See Figure A.11). The user needs to approve these recommendations for *TradaX* to implement them (Click *Select All* button to approve all at once, or check each individual recommendation one by one).

Click “Accept” to approve the checked recommendations.
Figure A.11 Fixing Recommendations
**Balance Data General Information Page**

The user can designate the balancing interval. (e.g., the user may wish to balance data from 3:00pm to 6:00pm) See Figure A.13

---

**Balance Data ConFigure A.uration**

**Balance Interval**

The user can designate the balancing interval. (e.g., the user may wish to balance data from 3:00pm to 6:00pm) See Figure A.13
External Data File

The user can also designate Lock Station file and Flag Station File. If such files are not needed, leave the input blank. See Figure A.14.

![Figure A.14 External Data Files Setup](image)

Lock Station File

By “lock”, it is meant that the data in this file is considered to be error-free; hence in the subsequent balancing process, these data will be left untouched, while other “non-locked” station will be modified whenever necessary by the algorithm to achieve balanced results.

The data in the Lock Station File could be results from other freeway balancing. For example, the “locked” station could be one of the boundary stations that are shared by two freeways. If the data of such station have already been balanced for one freeway, then the user may wish to lock this station when proceed to balance the other. “Lock Station” is useful especially when the user intends to balance loop detector station data on a network-wide basis.

Lock Station File should be strictly in the following format:
NOTE:
1. The file may have more data lines depending on the number of locked stations.
2. Comment lines are not parsed by the program.
3. The Data Line MUST be comma separated. NO TAB are allowed in the file (Be cautious! The program is VERY sensitive when parsing the Load Station File.)
4. It is stressed in the strongest term that ONLY Boundary stations (i.e., upstream freeway entrance station and ramp entrance/exit stations) can be lock stations. The program can still generate outputs when non-boundary stations (e.g., mainline stations) are locked, but the user should be warned that the results are not reliable.
5. It is VERY important that the number of data items in the data line match the number of time stamps determined by start time and end time. For example, start time 14:00 and end time 15:00 with 15 minutes time intervals, would give 5 time stamps, i.e., 14:00, 14:15, 14:30, 14:45, 15:00. If the data line includes 6 data items, e.g., 300,350,325,340,332,360, then this data line is inconsistent with the time stamps. This situation should be strictly avoided.

Flag Station File
This function is added because during the data fixing stage, certain data errors can not be properly filtered and corrected, for example, the kind of errors illustrated in the following Figure A.15 This kind of errors is unusual and can only be discovered through visual checking. However, errors like this have to be corrected in order to ensure the credibility of balancing results.

The data in the Flag Station File will be used to replace the recommended fixing proposed by the program when the user determines the latter is not reliable. Note the TradaX program will modify the Flag Station data whenever necessary to achieve balanced results.
Flag Station File must comply with the following format:

| Data Overwriting Start Time |
| 14:00 |
| Data Overwriting End Time |
| 15:00 |
| Number of Locked Stations |
| 1 |
| staID,14:00,14:15,14:30,14:45,15:00 |
| 1355,300,350,325,340,332 |

where
Line 1: Comment line for the start time of the locked data
Line 2: Start Time of the locked data
Line 3: Comment line for the end time of the locked data
Line 4: End Time of the locked data
Line 5: Comment line for the number of locked stations
Line 6: Number of locked stations
Line 7: Comment line, this line includes the time stamps for notational purposes
Line 8: Data line, which must be comma separated; the first item must be the station ID, other items are the volumes.
The file may have more data lines depending on the number of flagged stations. Comment lines are not parsed by the program. The Data Line MUST be comma separated.

Figure A.15 An unusual data error that can not be properly filtered
Warning Setup
The user can activate the Warning Message Setup for balancing. This means a warning message will be generated if the zone balance (i.e., the difference between total input volume and output volume of a zone) exceed the user-defined threshold. See Figure A.16

![Figure A.16 Balancing Warning Setup](image)

Start Balance
Click Balance button to start balancing. A Balance Log will pop up when the program completes balancing. See Figure A.17

![Figure A.17 Balancing Log](image)
ZoneID
The “ZoneID” is a combination of upstream and downstream station IDs for the freeway section has these two stations as endpoints.

I/O difference_1
This is the difference of total input volume and output volume before the balancing.

I/O difference_2
This is the difference after balancing. *TradaX* always balances I/O difference_2 to zero. A warning message will be put to NOTE if I/O difference_1 exceeds the user-defined threshold.

Balance Outputs
The user can specify the output format for the balanced data. See Figure A.18. Note Output Time Interval is the same as the Balance Interval, which can only be modified through “Balancing Configuration” page.

![Figure A.18 Balance Outputs Setup](image)

Figure A.18 Balance Outputs Setup
Example of Column Format (including Balanced/Fixed/Raw Volumes):

![Column Format Example](image1)

Example of Row Format (includes Balanced Volumes only):

![Row Format Example](image2)
**DATA GRAPHICS**

Data Graphics General Information Page

![Data Graphics General Information Page](image1.png)

Figure A.19 Data Graphics General Information Page

**Data Graphics Plot Page**

Select Station ID or Detector ID from the Tree View List, specify Time Interval, then click *Plot* button.

![Data Graphics Plot Page](image2.png)

Figure A.20 Data Graphics Plot Page
Data Plot

The data plot includes plots for Raw Data, Fixed Data, and Balanced Data. See Figure A.21.

![Data Plot](image)

Figure A.21 *TradaX Data Plot*

**ON-LINE HELP**

The user can start on-line help (See Figure A.22) by click *Start Help Engine* on the Help Content Page.

![On-Line Help](image)

Figure A.22 *TradaX On-Line Help*
Appendix B

Arterial Intersection Data Balancing Tool

ArtBaT 1.0

User Manual
**OVERVIEW**

Figure B.1 gives a snapshot of the main interface of *ArtBaT*. As is shown in this figure, *ArtBaT* interface has **four major components:**

1. Geometry Type Library;
2. Drawing Area;
3. Draw Function Keys;
4. Balancing Direction Selection Radio Button;

It is through these components that the user interacts with *ArtBaT* to balance arterial intersection data.

**Geometry Type Library**

Geometry Type Library contains all the possible arterial intersection types that could be encountered in practice. By clicking the geometry type icons, the user can build a certain layout of several intersections. So far, *ArtBaT* program can handle up to 17 types of intersections.

**Drawing Area**

Drawing Area is where the user builds and configures intersection geometries. Up to SIX intersections (of different types) can be balanced using *ArtBaT* program.

**Draw Function Keys**

- **Clear Draw**: Clear the entire drawing area;
- **Undo Last**: Delete the last intersection;
- **Refresh**: Refresh the drawing area;
- **Check Draw**: Check the geometry configuration before run “balancing data” command.
Balancing Direction Selection Radio Button

- Select relevant radio button to designate the balancing direction.

Figure B.1 Snapshot of ArtBaT User Interface


**MENU ITEMS**

*ArtBaT* has six menu items: **File, Data, Output, Run, Help** and **About**.

**File**

- **Load Scenario**: Load existing balancing scenario;
- **Save Scenario**: Save current configurations as scenario ( *.sco* );
- **Exit**: Exit the *ArtBaT* program

**NOTE**

A scenario file consists of the following information:

- Number of intersections to be balanced;
- Intersection types for each intersection;
- Intersection Data Files;

**Data**

- **Load Intersection Data File**: This command loads intersection data file.

**NOTE:**

Intersection Data File must comply with the following format (which is the same format as JAMAR file, See Figure B.2)

1. TXT file format (can be edited using notepad.exe)
2. Line 1 to line 10, inherited format from JAMAR file format, carrying no specific meaning to *ArtBaT* program;
3. Line 11 to the last line: must be comma separated, containing 1 time stamp column (i.e., the 1st column) and 16 data columns (i.e., 2nd to 17th columns)
4. For those turning movements related to freeway entering/exiting ramps, *ArtBaT* assumes the user has already conducted necessary data matching/splitting (See Section 2.2), i.e., the data file to be loaded by *ArtBaT* are the already-matched data;
5. The user is suggested in the strongest term to examine the JAMAR data file prior to inputting required column numbers.
6. Total number of data lines that *ArtBaT* can handle is 96 (this is based on the assumption that the data are on 15-min basis and 24 hours contain ninety-four 15-min intervals)
Figure B.2 A Sample of Intersection Data File

**Output**

- **Output Directory:** Designate output directory for the balancing results.

**NOTE:**

- Balancing results will be stored in the designated output directory as *.csv files that can be opened with Excel;

- One intersection will have two output files associated with it, i.e., `intersection_name.csv`, which contains integer-valued balanced results, and `intersection_name_float.csv`, which contains floating point valued balanced results. Here “intersection_name” represents the name of the intersection in question.

**Run**

- **Balance Data:** this command will execute the data balancing subroutine on the intersections.

**NOTE:** Run-> Balance Data command is disabled unless the intersections pass geometry check (to perform geometry check, click “Check Draw” button)
EXAMPLE

The following example illustrates in detail how to use ArtBaT program. Assuming we are to balance the intersections as shown in Fig 3. We have four intersections in this figure: D, C, B, A. The four intersection data files involved are:

1. “CSAH73 at No Frontage Rd.txt” corresponding to Intersection D;
2. “CSAH73 at I394 No Ramp.txt” corresponding to Intersection C;
3. “CSAH73 at I394 So Ramp.txt” corresponding to Intersection B;
4. “CSAH73 at So Frontage Rd.txt” corresponding to Intersection A;

Step 1: Start ArtBaT.exe

Step 2: Designate Data Files through Data → Load Intersection Data File (See Fig 4);

Step 3: Load the four intersection data files (See Figure B.5) and click Save

1. “CSAH73 at No Frontage Rd.txt” corresponding to Intersection D;
2. “CSAH73 at I394 No Ramp.txt” corresponding to Intersection C;
3. “CSAH73 at I394 So Ramp.txt” corresponding to Intersection B;
4. “CSAH73 at So Frontage Rd.txt” corresponding to Intersection A;
Figure B.4 Load Intersection Data Files Dialogue
**Step 4:** Click “North-South” radio to tell the program that the balancing is for north-south direction;

**Step 5:** Click 4 times icon and we have Figure B.6. The intersections are lined from top to bottom.
Step 6: Click the top 1st intersection; we have the configuration window as shown in Figure B.7

- Input Intersection Name (An intersection MUST be associated with an UNIQUE name);
Figure B.7 Configuring First Intersection

Step 7. Configure B.Intersection Legs. Take SB Leg of the first intersection as an example.

SB Leg, Left turn movement

- Select Data Source File from the file list, in this case, select “CSAH 73 at No Frontage Rd.txt” (Figure B.11);
- Input “1” in Col Number, as the first data column of “CSAH 73 at No Frontage Rd.txt” data file corresponds to SB left turn movements (Figure B.11);
- Check “Lock Left Turn Movement” if SB LT is supposed to be locked during the balancing process.
- Do the same for other movements for SB leg
- Do the same for other legs and other intersections.

NOTE:
- The intersection configuration can be saved by “SaveToFile” button, and existing intersection file can be loaded by “LoadFromFile” Button;
• For a turning movement that doesn’t actually exist, the user should designate its Data Source File as empty and Col Number as “0”;
• When it is desired that some turning movements counts should not changed during the balancing, the user must designate such movements as “LOCKED” by checking the respective “Lock XXX turn movement” checkbox (Figure B.8).

Figure B.8 Configure B.SB Intersection Leg
Step 8: After all intersections are configured (Fig 13), click “Check Draw” to check the geometry.
**Step 9:** Because we have not designate output directory path, the geometry check fails (See Figure B.11)

**Figure B.11 Check Draw Information Dialogue**

**Step 10:** Input Output Directory Path through **Output → Output Directory** command (Figure B.12), and check geometry again. If passed, **Run → Balance Data command** will be enabled.

**Step 11:** Click Run → Balance Data and the balanced results (from North to South, and from South to North balancing) will be output to the designated directory.

**Step 12:** The user can save the balancing scenario through “File → Save Scenario”. Saved scenario includes the following information:

- Number of intersections;
- Intersection Type for each intersection;
- Intersection data files as loaded from “Data → Intersection Data File”
Figure B.12 Designate Output Directory Path